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page of this document. 
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http://support.automation.siemens.com/WW/view/en/45287799
mailto:online-support.automation@siemens.com


Warranty and Liability
 

SINAMICS G120D, control via PROFINET 
V1.0, Beitrags-ID: 45287799 3

 

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
0 

A
ll 

rig
ht

s 
re

se
rv

ed
 

G
12

0D
_S

TD
_A

P
P

2_
en

.d
oc

 
  

Warranty and Liability 
Note The Application Examples are not binding and do not claim to be complete 

regarding the circuits shown, equipping and any eventuality. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for ensuring that 
the described products are used correctly. These application examples do not 
relieve you of the responsibility to use safe practices in application, installation, 
operation and maintenance. When using these Application Examples, you 
recognize that we cannot be made liable for any damage/claims beyond the 
liability clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice.  
If there are any deviations between the recommendations provided in these 
application examples and other Siemens publications – e.g. Catalogs – the 
contents of the other documents have priority. 

 

We do not accept any liability for the information contained in this document. 

Any claims against us – based on whatever legal reason – resulting from the use of 
the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of a condition which goes to the root of the contract 
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden of 
proof to your detriment. 
 
Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of Siemens Industry Sector. 
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1 Automation function
 

1 Automation function 
1.1 Description of the functionality 

The SINAMICS G120D drive inverter is a modular inverter system with degree of 
protection IP65. It comprises the two function units Control Unit (CU) and Power 
Module (PM). 
When using the Control Unit CU240D PN, you have the possibility to use the 
PROFINET IO interface. This interface can be used for data exchange between 
inverter and control and to run the drive with the control. 
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2 Functionality of the function example 
 

2 Functionality of the function example 
2.1.1 Task description 

The SINAMICS G120D is to be controlled from an S7-300 CPU via Profinet.  
 

2.1.2 Solution 

In this function example, the control of a SINAMICS G120D (control word and 
frequency setpoint) will be demonstrated using an S7-300 CPU and a specific 
program example.  
This program example comprises an S7 program to control the SINAMICS G120D 
and the appropriate configuration in the SINAMICS G120D. 
Further, the digital inputs of the SINAMICS G120D are cyclically read-in to the 
PLC. For instance, this function can be used in conveyor systems to read-in sensor 
signals into the PLC. 
 

2.2 Structure of the function example 

• In Chapter 3 the required hard and software components for the function-
examples are shown. 
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• The download and test of the program examples supplied are described in 
Chapters 4 to 5.  

• Chapter 6 informs about the key performance date. 
• In Chapter 7 more detailed information are delivered. These Steps are not 

necessary for the commissioning of the function-example and you don’t have 
to do these because they are already included in the S7-Program and 
accordingly the SINAMICS G120 Project. The given information should help 
you with the creation of your own projects.  
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3 Components that are required
 

3 Components that are required 
An overview of the hardware and software components required for the function 
example is provided in the Chapter. 

  

3.1 Hardware components 

Component Type Order No./ordering data Qty Manufacturer 

S7 control 

Power supply PS307 5A 6ES7307-1EA00-0AA0 1 

S7-CPU  CPU 315-2 PN / DP 6ES7315-2EH13-0AB0 1 

Memory Card MMC 512 KB 6ES7953-8LJ11-0AA0 1 

DI / DO simulation module SM374 6ES7374-2XH01-0AA0 1 

Profile rail Profile rail 6ES7390-1AE80-0AA0 1 

PROFINET RJ45 connector * PROFINET connector 6GK1901-1BB10-2AA0 4 

PROFINET cable* PROFINET cable 6XV1870-8AH50 5m 

SIEMENS 

Drive 

SINAMICS G120D Control Unit  CU240D PN (FW3.2) 6SL3544-0FA20-1FA0 1 

SINAMICS G120D Power 
Module  PM250D 1,5kW 6SL3525-0PE21-5AA0 1 

Three-phase induction motor Motor 1LA7080-4AA10 1 

Motor cable 1,5m Motor cable 6ES7194-1LA01-0AA0 1 

Power cable 1,5m Power cable 3RK1911-0DB13 1 

7/8“ connector for 24V power 
supply 7/8“ connector 6GK1905-0FB00 0,2 

SIEMENS 

 
* Two PROFINET cables (M12  RJ45) are required for this function example. You can 
easily fabricate these yourself by halving the PROFINET cable 6XV1870-8AH50 and then 
attaching the two RJ45 connectors 6GK1901-1BB10-2AA0. 
 

Note The functionality was tested with the specified hardware components. 
Similar components that are different from those listed above can be used. 
Please note that in such a case it may be necessary to change the code 
example (e.g. setting other addresses). 

3.2 Software components  

Component Version Order No. / ordering data Qty Manufacturer 

SIMATIC STEP 7 V5.4 + SP5 + 
HF1 6ES7810-4CC08-0YA5 1 SIEMENS 

http://support.automation.siemens.com/V4.1 + SP5 + 
HF1 STARTER 1 WW/view/en/26233208

http://support.automation.siemens.com/GSDML-File CU240D PN V3.2 1 WW/view/en/26641490

SINAMICS G120D, control via PROFINET 
V1.0, Beitrags-ID: 45287799 7
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4 Configuration and wiring 
 

4 Configuration and wiring 
The hardware configuration and connecting-up the function example are described 
in this Chapter. 
Please carefully observe the following safety information & instructions when using 
the SINAMICS G120D: 

 ! The SINAMICS G120D has hazardous voltages and controls rotating mechanical 
parts that can also be potentially hazardous. If the warning information is not  
observed or the information & instructions from the instructions belonging to Warning 
SINAMICS G120D are not complied with this could result in death, severe bodily 
injury or significant material damage. 

 

4.1 Overview of the hardware configuration 
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4.2.1 S7-300 control and CU240D PN-F 

4.2 Connecting-up the hardware components 
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4.2.2 PM250D and motor 

 
For more detailed information regarding the installation please refer to the SINAMICS G120D Getting Started. Download from: 

http://support.automation.siemens.com/WW/view/en/25021636/133300
 

http://support.automation.siemens.com/WW/view/en/25021636/133300
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4.3 Fault 395 (acceptance test / acknowledgement present) 

Fault F395 is output when powering-up for the first time and after replacing the 
Control Unit (CU) or the Power Module (PM). 
This fault does not represent an incorrect drive inverter function. The reason for 
this fault message is to monitor the individual drive inverter components (CU and 
PM) to prevent them from being replaced by unauthorized personnel. 
 
Acknowledging fault F395  
Just like any other fault, it can be acknowledged using an appropriately 
parameterized input, via the field bus or using the STARTER parameterizing 
software. 

4.4 Important hardware component settings 

Most of the module/board settings are made in the HW Config in the software. 
Hardware settings are only required for the following modules/boards.  
The modules/boards must be set with the control system in a no-voltage state. 

4.4.1 SM374 simulation module  

This module can be operated as 16 x DO (output via LED), 16 x DI (input via 
switch) or as combined 8 x DI / 8 x DO. The last combination is used in this 
function description.  
The function of the module is selected using a rotary switch behind the front cover 
between the series of switches.  
As shown in the following diagram set the function switches to the setting 8 x 
Output 8 x Input. 
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4.5 Overview of inputs and outputs 

4.5.1 Simulation module SM374 

 
 

Address Function Symbolic address Default Explanation  

O 0.0 Status_G120D_DI_0 
… 

Status G120D 
digital inputs DI0 

… DI5 

The status of the G120D digital inputs DI0 to DI5 are 
output to the PLC via these outputs. 0 … 

Status_G120D_DI_5O 0.5 

Indicator lamp 
Safety functions 
active or error 

O 0.7 Safe_stop_or_error 0 Fault active is signaled via this output 

 

SINAMICS 
G120D start I  0.0 Start_G120D 0 The motor connected to SINAMICS G120D is started by 

activating the input 

SINAMICS 
G120D reverse I  0.1 Reverse_G120D 0 After the input is activated, a negative frequency setpoint 

is entered (direction of rotation reversal) 

Increase 
frequency I  0.5 Increase_frequency 0 The motor frequency can be increased using this input  

Decrease 
frequency I  0.6 Decrease_frequency 0 The motor frequency can be reduced using this input  

Acknowledge 
error I  0.7 ACK_error 0 Fault messages that are present can be acknowledged 

using this input. 
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4.5.2 SINAMICS G120D 

The SINAMICS G120D is controlled and the feedback signals read-in via the I/O 
addresses listed below. 

 

Address Function 

S7 program -> SINAMICS G120D 

PQW256 Control word 1 

PQW258 Frequency setpoint 

PQW260 Torque setpoint 

PQW262 Control word 2 

PQW264 -- Reserve -- 

PQW266 -- Reserve -- 

SINAMICS G120D -> S7 program 

PIW256 Status word 1 

PIW258 Frequency actual value 

PIW260 Status of the SINAMICS G120D binary inputs 

PIW262 Status word 2 

PIW264 Last fault number 

PIW266 Last alarm number 

 

For more detailed information about the configuration of the individual signals, 
please refer to SINAMICS G120D CU240D Operating Instructions  Chapter 
Commissioning, Commissioning with PROFINET. 

Download from: 
http://support.automation.siemens.com/WW/view/en/25021636/133300

 

http://support.automation.siemens.com/WW/view/en/25021636/133300
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5 Download 
5.1 S7 program 

To download the S7 program, you will require a connection between the MPI 
interface of your PG/PC and the MPI interface of the S7 CPU. 
• Start the SIMATIC Manager. 
• De-archive the function example supplied. 
• Open the G120D_STD_APP2 project. 
• Select the MPI interface parameterization using Options > Select PG/PC 

interface… . 
• Open HW-Config and download this into the control. After the download re-

close HW-Config. 
• In SIMATIC Manager, select the block folder via CPU315-2 PN/DP > S7 

Program > Blocks. 
• Download all of the S7 program blocks into the CPU 
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5.2 Setting the SINAMICS G120D IP address and device 
name 

Different than for Profibus, for PROFINET, the node addresses are not set in the 
hardware, but in the software. To do this, a connection is required between the 
PG/PC and the PROFINET interface of the SINAMICS G120D via TCP/IP. 
• To do this, connect the PROFINET cable from the SINAMICS G120D, interface 

X03 P2 to the Ethernet interface (port) of your PG/PC (refer to Chapter 4.1).  
• Set the IP address and the subnet mask of the Ethernet card of your PG/PC as 

follows. 
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• Using Options > Set PG/PC Interface…. select the TCP/IP interface 
parameterization. You can carry out all additional steps via this interface during 
the course of the function example.  

 

 
 
• Then, using PLC > Edit Ethernet Node…, open the dialog box Edit Ethernet 

Node.  
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• Press the Browse… button  
 

 
 
• In the dialog box that then opens, select the node with the SINAMICS device 

type and then press the OK button. 
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• (1.) Now, enter under IP-adresse: 192.168.0.2 and under Subnetmask: 
255.255.255.0. (2.) Then press the Assign IP Configuration button. 

 

 
 
• (3.) After completing the IP configuration assignment, enter the device name - 

assigned in HW Config - under Device name: (in this particular function 
example, g120d). (4.) This is then assigned to the SINAMICS G120D by 
pressing the Assign Name button. 

• Close the mask by pressing the Close button. 
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5.3 SINAMICS G120D configuration 

When this has been completed, download the SINAMICS G120D configuration 
using the STARTER parameterizing tool.  
• Starting from the main path of the SIMATIC Manager, start the STARTER 

parameterizing software by selecting the SINAMICS_G120D icon and double 
click on the Inbetriebnahme icon. 

 

 
 

• Then, in the Project Navigator of the STARTER parameterizing software select 

the object "G120D" (1.) and press the button  (2.) to establish the online 
connection to the drive inverter. 

 

 
 

• After you have established the online connection, press the button  to 
download the SINAMICS G120D drive parameters. 

• Follow the instructions on the screen and acknowledge the prompt "After 
loading, copy RAM to ROM". 
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5.4 Exiting the STARTER parameterizing software 

• If you don't wish to set any additional parameters, then you can now exit the 
STARTER commissioning tool. 

• In the tree select SINAMICS G120D and transfer all of the parameter changes 

into the ROM memory of the SINAMICS G120D by pressing the  button 
• Then transfer all of the parameters into your offline a project by pressing the  

 button. 

• Disconnect the PG / PC from SINAMICS G120D by pressing the  button. 

• Now you can close STARTER using Project > Close or by pressing the  
button. 
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6 Key performance data of the SIMATIC CPU 
Load memory and working memory 

 Total 

Load memory Approx. 6 k 

Working memory Approx. 2 k 

Cycle time 

Total cycle time (typical) Approx. 1ms 
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7 Background information 
The individual functions of the example code are explained in the following 
Chapters so that you will then be in a position to implement your own project. 
For this function example, the settings described no longer have to be made. 
 

7.1 Settings in the hardware configuration 
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7.1.1 Properties of the SINAMICS G120D 

The window of the SINAMICS G120D PROFINET properties (2.) is displayed by 
clicking once on the SINAMICS G120D icon (1.). 
 

 
 
The PROFINET telegram (2.) between the CPU and the SINAMICS G120D is the 
Standard Telegram, in this particular example, Standard Telegram 352 for the 
communications of the SINAMICS G120 (control signals, status signals, frequency 
setpoint, frequency actual value etc.) 
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The telegram is selected in the Catalog after pressing the  button. 
 

 
 

You can download the GSDML files for the SINAMICS G120D under the following 
link: http://support.automation.siemens.com/WW/view/en/26641490
GSD files are required to operate a node (e.g. the SINAMICS G120D) on 
PROFINET – and to register (log-on) the device to the engineering tool. 
 

http://support.automation.siemens.com/WW/view/en/26641490
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7.1.1.1 Standard Telegram  

 
 

Various pre-assigned telegrams are available for this communication; these can be 
selected from the hardware catalog (refer to 6.1.3). 
The Standard Telegram 352 is used in this function example. It contains a length 
of 6 words sending (output) and receiving (input) – beginning from starting address 
256. 
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7.2 Functions of the Step 7 program 

7.2.1 Program overview 

 
 
The Step 7 program essentially comprises blocks FB10, FC100 and DB1 that are 
called in the cyclic program (OB1). 
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7.2.2 DB1, axis_DB 

The axis_DB represents the interface between the S7 program and the SINAMICS 
G120D via FC100. 
Axis_DB is generated from UDT 2 (Axis_DB_G120D) 
 

Structure of axis_DB: 

Address Symbolic name Type Function 

Internal data 

DBW 0 Basic_Data.Moduleadress INT I/O start address of the SINAMICS G120D (refer to 
HW Config) 

DBB 3 Basic_Data.Drivetyp Byte Drive type, must be 3  

S7 -> SINAMICS G120D 

DBW 4 Control_signals.STW2 Bool Control word 2 (for details, refer to the S7 program) 
DBW 6 Control_signals.STW1 Bool Control word 1 (for details, refer to the S7 program) 
DBW 8 Control_signals.Frequency_set INT Frequency setpoint in x.x %  
DBW 10 Control_signals.Torque_set INT Torque setpoint in x.x %  
DBW 12 Reserve Word Reserve 

SINAMICS G120D -> S7 

DBW 14 Status_signals.ZSW2 Bool Status word 2 (for details, refer to the S7 program) 
DBW 16 Status_signals.ZSW1 Bool Status word 1 (for details, refer to the S7 program) 
DBW 18 Status_signals.Actual_frequency INT Frequency actual value in x.x %  
DBW 20 Status_signals.binary_inputs Bool Status of the SINAMICS G120D binary inputs 
DBW 22 Reserve Word Reserve 

Error messages 

DBW 24 Faults.Drive_error_number INT Actual error number of the SINAMICS G120D 
DBW 26 Faults.Drive_alarm_number INT Actual alarm number of the SINAMICS G120D 

 
In this function example the individual data of the DB1 are supplied in FB10. 
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7.2.3 FB10, Organization  

This block is called-up in absolute terms in OB1 and in turn calls up FC100. 
 

Principle of the FB10 

Network Function 

1 Calls the FB11 to generate the frequency setpoint 

Controls the SINAMICS G120D via the axis-DB, DB1. 
Calls the SINAMICS G120D control block FC100.  
Provides the feedback signals – incl. error and alarm number 

2 

This network can be used as template for additional SINAMICS G120D control functions. 
3 Controls the signal lamp for fault. 

 

7.2.4 FC100, Control of SINAMICS G120D 

SINAMICS G120D is controlled using the FC100 via PROFINET.  
Only signals from the Axis_DB are used to control the block - but no fixed 
addresses - this is the reason that instances can be used.  
This block can be used in the same way for both a standard and a Safety 
SINAMICS G120D. 
 

Formal operands of the FC100 

Formal operands Type Description 

Nr_Axis_DB IN Number of the Axis-DB generated using UDT2  

Internal_Error OUT 
Displays an internal error     
0 = no error 
1 = incorrect Axis-DB type (wrong UDT) 

 
Principle structure of the FC100 

Network Function 

Opens the Axis_DB specified using the formal operands Nr_Axis_DB. 
1 

Generates the internal error message. 

2 Reads-in the SINAMICS G120D status words, processes these and saves them in the 
Axis_DB. 

3 Resets internal error messages. 

4 Converts frequency and torque setpoint from the Axis_DB (entered in x.x %) into the 
SINAMICS G120D format (hex). 

5 Enters SINAMICS G120D error and alarm number into the Axis_DB. 
6 Sends control words from the Axis_DB to the SINAMICS G120D 
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7.3 SINAMICS G120D parameterization 

7.3.1 SIMATIC Manager - inserting SINAMICS G120D , 

• In SIMATIC Manager select the tree G120D_STD_App_2 and using Insert > 
Program > SINAMICS select a SINAMICS G120D type object. 

 
 
• Make the following settings and press the OK button.  
 

 



7 Background information 
 

30 
SINAMICS G120D, control via PROFINET 

V1.0, Beitrags-ID: 45287799 
 

C
op

yr
ig

ht
 ©

 S
ie

m
en

s 
A

G
 2

01
0 

A
ll 

rig
ht

s 
re

se
rv

ed
 

7.3.2 Calling the STARTER parameterization tool  

• Starting from the main path of the SIMATIC Manager, start the STARTER 
parameterization software by selecting SINAMICS_G120_CU240D  and 
double click on Inbetriebnahme. 

 
 
• Then, in the Project Navigator of the STARTER  

parameterization software select the object G120D (1.) and press button  
(2.) to establish an online connection to the drive inverter. 

 
 

7.3.3 STARTER - carrying out quick commissioning 

• The screen form with the actual configuration is opened by double clicking on 
Configuration in the Project Navigator. 

• The quick commissioning Wizard is started after pressing the 
 button. 

• Enter the appropriate values into the Control structure to Encoder screen 
forms. You can call-up corresponding help texts in the individual screen forms 
by pressing on the Help button.  

• In the screen form Drive functions, select for Motor identification, the function 
Ident. of all param. in standstill incl. the saturation curve (3). 

• Enter the corresponding parameters into the Important parameters screen 
form. 

• In the screen form Calculation of the motor data, select Restore factory 
setting and calculate motor data. 

• In the screen form Summary do not activate the function RAM -> ROM, but 
instead press the Finish button. 
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7.3.4 STARTER - carrying out a motor identification routine 

• After completing the quick commissioning, alarm A0541 (Motor data-
identification active) is displayed. Please carefully note that when starting the 
motor identification routine current flows in the motor. For hanging (suspended) 
axes the load must always be supported.  

• To start the motor data identification routine, in the Project Navigator select the 
menu item Commissioning and activate by double clicking on Control panel. 

 
 
• Press Assume control priority and carefully note the security/safety 

information and instructions. Then activate Enables. 

 
 
• 1.) If the Control panel isn't completely displayed on your PG/PC, then press 

the  button. 

• The motor data identification routine is started by pressing the  button. Do 
not exit the STARTER software and go to another task as otherwise the motor 
data identification routine will be interrupted for safety reasons.  

• Please wait until the  button changes back to the  button. 
• Return the control priority to the S7 control by pressing the 

 button. 
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7.3.5 STARTER - setting the PROFINET communications 

• Communications between the CPU and the SINAMICS G120D must then be 
parameterized. To do this, open the screen for the communication settings 
using Communication -> PROFINET. Select the tab Transmit direction. 

• To start, select the Standard-Telegram 350 (350) from Message frame: (1.). 
This pre-assigns the telegram. 
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• Then replace telegram 350 by telegram type (999) Free BICO connection (1.). 
Deactivate any possibly active Suppress inactive interconnections function 
(2.) and establish the following interconnections (3.): 

• PZD 3 = r722 (Binary input values = Status of the digital inputs) 
• PZD 5 = r2131 (Last fault number code) 
• PZD 6 = r2132 (First warning number code) 

 

 
 
• Finally, you only have to save the SINAMICS G120D configured software in 

the ROM memory of the drive inverter. To do this in the Project Navigator 
select the menu item SINAMICS_G120_CU240D 

 

 
 

 button. • In the function bar press the 
• Please wait until the download operation has been completed. 
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8 Appendix 
 

8.1 Internet link data 

Subject area Title 

SIEMENS Customer 
Support Homepage 

http://support.automation.siemens.com

Safety function 
examples 

http://support.automation.siemens.com/WW/view/en/2081
0941

SINAMICS G120D 
documentation 

http://support.automation.siemens.com/WW/view/en/2502
1636/133300

SINAMICS G120D 
Homepage 

http://www.automation.siemens.com/mcms/standard-
drives/en/low-voltage-inverter/sinamics-
g120d/Pages/sinamics-g120d.aspx

 
 

8.2 History 

 

Version Datum Change 

V1.0 July 2010 First edition 
   

 

http://support.automation.siemens.com/
http://support.automation.siemens.com/WW/view/en/20810941
http://support.automation.siemens.com/WW/view/en/20810941
http://support.automation.siemens.com/WW/view/en/25021636/133300
http://support.automation.siemens.com/WW/view/en/25021636/133300
http://www.automation.siemens.com/mcms/standard-drives/en/low-voltage-inverter/sinamics-g120d/Pages/sinamics-g120d.aspx
http://www.automation.siemens.com/mcms/standard-drives/en/low-voltage-inverter/sinamics-g120d/Pages/sinamics-g120d.aspx
http://www.automation.siemens.com/mcms/standard-drives/en/low-voltage-inverter/sinamics-g120d/Pages/sinamics-g120d.aspx
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